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Safety precautions 
Observe the following safety precautions before using this product and any associated 
instrumentation. Although some instruments and accessories would normally be used 
with nonhazardous voltages, there are situations where hazardous conditions may be 
present. 
This product is intended for use by qualified personnel who recognize shock hazards 
and are familiar with the safety precautions required to avoid possible injury. Read and 
follow all installation, operation, and maintenance information carefully before using the 
product. Refer to the user documentation for complete product specifications. 
If the product is used in a manner not specified, the protection provided by the product 
warranty may be impaired. 
The types of product users are: 

Responsible body is the individual or group responsible for use and maintenance of 
equipment, for ensuring that the equipment is operated within its specifications and 
operating limits, and for ensuring that operators are adequately trained. 
Operators use the product for its intended function. They must be trained in electrical 
safety procedures and proper use of the instrument. They must be protected from 
electric shock and contact with hazardous live circuits. 
Maintenance personnel perform routine procedures on the product to keep it 
operating properly, for example, setting the line voltage or replacing consumable 
materials. Maintenance procedures are described in the user documentation. The 
procedures explicitly state if the operator may perform them. Otherwise, they should be 
performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and 
repair products. Only properly trained service personnel may perform installation and 
service procedures. 
Keithley Instruments products are designed for use with electrical signals that are 
measurement, control, and data I/O connections, with low transient overvoltages and 
must not be directly connected to mains voltage or to voltage sources with high 
transient overvoltages. Measurement Category II (as referenced in IEC 60664) 
connections require protection for high transient overvoltages often associated with 
local AC mains connections. Certain Keithley measuring instruments may be connected 
to mains. These instruments will be marked as category II or higher. 
Unless explicitly allowed in the specifications, operating manual, and instrument labels, 
do not connect any instrument to mains. 
Exercise extreme caution when a shock hazard is present. Lethal voltage may be present 
on cable connector jacks or test fixtures. The American National Standards Institute 
(ANSI) states that a shock hazard exists when voltage levels greater than 30 V RMS, 
42.4 V peak, or 60 V DC are present. A good safety practice is to expect that hazardous 
voltage is present in any unknown circuit before measuring. 
Operators of this product must be protected from electric shock at all times. The 
responsible body must ensure that operators are prevented access and/or insulated from 
every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect 
themselves from the risk of electric shock. If the circuit is capable of operating at or 
above 1000 V, no conductive part of the circuit may be exposed. 



 

 

Do not connect switching cards directly to unlimited power circuits. They are intended 
to be used with impedance-limited sources. NEVER connect switching cards directly to 
AC mains. When connecting sources to switching cards, install protective devices to 
limit fault current and voltage to the card. 
Before operating an instrument, ensure that the line cord is connected to a 
properly-grounded power receptacle. Inspect the connecting cables, test leads, and 
jumpers for possible wear, cracks, or breaks before each use. 
When installing equipment where access to the main power cord is restricted, such as 
rack mounting, a separate main input power disconnect device must be provided in 
close proximity to the equipment and within easy reach of the operator. 
For maximum safety, do not touch the product, test cables, or any other instruments 
while power is applied to the circuit under test. ALWAYS remove power from the 
entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, 
such as installing or removing jumpers. 
Do not touch any object that could provide a current path to the common side of the 
circuit under test or power line (earth) ground. Always make measurements with dry 
hands while standing on a dry, insulated surface capable of withstanding the voltage 
being measured. 
For safety, instruments and accessories must be used in accordance with the operating 
instructions. If the instruments or accessories are used in a manner not specified in the 
operating instructions, the protection provided by the equipment may be impaired. 
Do not exceed the maximum signal levels of the instruments and accessories, as defined 
in the specifications and operating information, and as shown on the instrument or test 
fixture panels, or switching card. 

When fuses are used in a product, replace with the same type and rating for continued 
protection against fire hazard. 
Chassis connections must only be used as shield connections for measuring circuits, 
NOT as protective earth (safety ground) connections. 
If you are using a test fixture, keep the lid closed while power is applied to the device 
under test. Safe operation requires the use of a lid interlock. 

 

If a screw is present, connect it to protective earth (safety ground) using the wire 
recommended in the user documentation. 

 

This symbol on an instrument means caution, risk of danger. The user should refer 
to the operating instructions located in the user documentation in all cases where 
the symbol is marked on the instrument. 

 

This symbol on an instrument means caution, risk of electric shock. Use standard 
safety precautions to avoid personal contact with these voltages. 

 

This symbol on an instrument shows that the surface may be hot. Avoid personal 
contact to prevent burns. 

 

This symbol indicates a connection terminal to the equipment frame. 

 

If the mercury symbol is on a product, it indicates that mercury is present in the 
display lamp. Please note that the lamp must be properly disposed of according to 
federal, state, and local laws. 

WARNING This heading in the user documentation explains dangers that might result 
in personal injury or death. Always read the associated information very 
carefully before performing the indicated procedure. 

CAUTION This heading in the user documentation explains hazards that could 
damage the instrument. Such damage may invalidate the warranty. 



 

  

Instrumentation and accessories shall not be connected to humans. 

Before performing any maintenance, disconnect the line cord and all test cables. 

To maintain protection from electric shock and fire, replacement components in mains 
circuits —  including the power transformer, test leads, and input jacks —  must be 
purchased from Keithley Instruments. Standard fuses with applicable national safety 
approvals may be used if the rating and type are the same. Other components that are 
not safety-related may be purchased from other suppliers as long as they are equivalent 
to the original component (note that selected parts should be purchased only through 
Keithley Instruments to maintain accuracy and functionality of the product). If you are 
unsure about the applicability of a replacement component, call a Keithley Instruments 
office for information. 

To clean an instrument, remove power from the instrument. Use a damp cloth or mild, 
water-based cleaner. Clean the exterior of the instrument only. Do not apply cleaner 
directly to the instrument or allow liquids to enter or spill on the instrument. Products 
that consist of a circuit board with no case or chassis (e.g., a data acquisition board for 
installation into a computer) should never require cleaning if handled according to 
instructions. If the board becomes contaminated and operation is affected, the board 
should be returned to the factory for proper cleaning and servicing. 
Safety precaution revision as of January 2013. 
 

 

  



 

 

What is KickStart? 
Keithley KickStart is a software program that allows you to set up 
your instrument and run a test in a few simple steps: 

 Select your instrument 

 Select the test type 

 Configure the test 

 Run the test 
The flexible plug- in architecture of the KickStart software allows you 
to create and run tests for different instrument types from a single 
interface. 
 

Instrument and test plug-ins 
Keithley KickStart uses plug- in modules for instrument types and test 
types. These modules simplify instrument connection and test set up. 
They automatically configure some of the settings you need to get 
you started. 

The Keithley KickStart software comes with the following 
instrument and test plug- ins: 

 Model 2450 instrument plug- in (TSP mode only) 

 Model 2400 instrument plug- in 

 SMU Simulator instrument plug- in 

 Communication terminal test- type plug- in 

 IV Characterizer test- type plug- in 

The Model 2450 instrument plug-in only works when the Model 2450 
is using the TSP command set. The Model 2450 is shipped with the 
SCPI command set enabled; you must change it to TSP before 
attempting to use the Model 2450 instrument plug-in in KickStart. 

 



 

  

KickStart features 
Features of the Keithley Instruments KickStart software include: 

 Simple, customizable user interface 

 Automatic discovery of compatible instruments on a network 

 Communicate with instruments connected to your computer 
through the  GPIB, USB, and ethernet remote interfaces 

 Test- type plug- ins allow you to use advanced testing functions 
without knowledge of programming languages 

 Tests can be saved and used on other compatible instruments 

 Flexible graphing option allows you to see the results of your 
tests in real time 

 Spreadsheet view allows you to see individual data points 

 Recall, manipulate, and view data graphically from previously 
saved tests 

 Save test data to the Microsoft® Excel® 2007 .xlsx and .csv 
formats for use in Excel or other statistical analysis software 

 Save graph images to the portable network graphics (.png) file 
format for use in reports and presentations 

About the KickStart documentation 
This guide contains basic instructions and a few example applications 
for the KickStart software. Topics in this guide include: 

 Installation instructions 

 A tour of the KickStart interface and how to customize it 

 Basic instructions 

 Answers to frequently asked questions 

 References to additional sources of information 
 

Additional user information is available in the KickStart software 
help files. The help content can be found in several places in the 
KickStart interface: 

 Each test- type plug- in has a tab with additional information 
specific to the test type. 

 The blue help icon in the upper right corner of the interface links 
to a copy of this guide. 

Additional information specific to the Keithley instruments that you 
have is available on the Keithley Instruments website at 
http://www.keithley.com. 

http://www.keithley.com/


 

 

 

Contact information 
If you have any questions after you review the information in this 
documentation, please contact your local Keithley Instruments 
representative or call Keithley Instruments corporate headquarters 
(toll- free inside the U.S. and Canada only) at 1-888-KEITHLEY 
(1-888-534-8453), or from outside the U.S. at + 1-440-248-0400. For 
worldwide contact numbers, visit the Keithley Instruments website at 
http://www.keithley.com. 

 

 

 

 

 

  

http://www.keithley.com/


 

  

Install the software 
You can install the KickStart software from the CD-ROM that came 
with your instrument, or you can download the software from 
http://www.keithley.com/support. 

Before you install the KickStart software: 

 You must have NI-VISA™ Runtime Engine installed on your 
computer. If you do not already have it installed, you can install it 
from the KickStart CD-ROM. 

 You must have the Microsoft® .NET Framework 4.0 installed on 
your computer. Most computers already have this installed, but if 
you do not have the 4.0 version, you can download it from the 
Microsoft website. 

 

To install the KickStart software on your 
computer: 
1. Insert the KickStart CD-ROM into the CD-ROM drive of your 

computer. 

2. Double-click the KickStartSetup.exe file to start the 
installation. 

3. Follow the prompts to complete the installation. 

4. Reboot your computer. 
 

http://www.keithley.com/support


 

 

Instrument and test-type plug-ins 
You can expand the test capabilities of KickStart by adding additional 
instrument-type and test- type plug- ins as they become available from 
Keithley Instruments. 

To download and install a new instrument or test-
type plug-in: 
1. Use a web browser to go to http://www.keithley.com/support. 

2. Enter kickstart in the search box. 

3. Click the arrow on the box next to the search box and select 
Software. 

4. Click the search icon. A list of software and software-related 
items for KickStart is returned. 

5. Select the plug- in file you want. Instrument plug- ins have 
a .kipi file extension; test- type plug- ins have a .ktpi file 
extension. 

6. Download the file to your computer. 

7. Open the KickStart software. 

8. On the File tab, click Load Plug-Ins. 

9. Select Instrument Plug-In or Test Type Plug-In. 

10. Navigate to the downloaded  plug-in, select the plug- in you want, 
and click Open. 

11. Close the KickStart software and then reopen it. The new 
plug- ins are now visible in the Instrument Configuration or Test 
Types panel, as applicable. 

 

 

http://www.keithley.com/support


 

  

Explore the interface 
To start the KickStart software, from the Start menu, select: 

 

KickStart opens to a welcome screen that has some general 
information about the software. 

The main screen areas of the KickStart software interface are: 

 The ribbon 

 The Instrument Configuration panel 

 The Test Types Panel 

 The main test window 

 KickStart Help 
 
 

The ribbon 
The ribbon at the top of the KickStart interface contains the File, 
Instruments, and Settings tabs. 

File tab. Contains options that allow you to create, open, and save 
tests, export data and graphs, and import plug- ins. 

 
 

Instruments tab. Contains global instrument control options that 
you can use to reset selected instruments, discover instruments on 
your ethernet network, and identify the instruments selected for test. 

 
 



 

 

Settings tab. Allows you to adjust how measurement data is saved. 

 
 
 
 
 
 
 
 

The Instrument Configuration panel 
The Instrument Configuration panel displays a list of instruments 
that are available to use with KickStart. When you click an instrument 
in the list, the lower part of the panel shows details about the 
instrument you have chosen. 

When you start the KickStart software, it searches for instruments 
that are compatible with the instrument plug- ins loaded in your 
installation of the software. 
 

If you do not see your instrument in the list: 

1. Click the Instruments tab. 

2. Click Refresh Instrument Discovery. 

KickStart searches for any compatible instruments on the network 
subnet. 

If you do not want to search for all instruments on the network 
subnet, clear the Discover Ethernet Instruments option. 
 

Instrument plug-ins 
The KickStart software comes with the following instrument 
plug- ins: 

 Model 2450 instrument plug- in (TSP command language only) 

 Model 2400 instrument plug- in 

 SMU Simulator instrument plug- in 
You can load additional instrument plug- ins as they become available 
from Keithley Instruments. For more information, see Install 
instrument or test- type plug- ins. 
 



 

  

The Test Types panel 
Click the Test Types tab to display a list of the test- type plug- ins that 
are loaded into your installation of the KickStart software. 

Test-type plug-ins 
KickStart comes with the following test- type plug- ins: 

 Communication Terminal. Allows you to communicate with 
an instrument using the Test Script Processor (TSP®) or SCPI 
command language. KickStart displays the commands that are 
sent and any output received from the instrument in the 
Communication Terminal output window. 

 I-V Characterizer. Allows you to quickly configure an 
instrument to perform complex source and measure tests without 
using a programming language. View the test data in real- time in 
a graph or spreadsheet view. 

 You can load additional test- type plug- ins as they become 
available from Keithley Instruments. 
 

 

The main test window 
The contents of the main window in KickStart varies depending on 
the test type you have chosen for your application. When a test is 
open, the main window contains several tabs that give you access to 
additional functionality and test- type specific help. 

Communication Terminal test window 
When the Communication Terminal test- type plug- in is selected, the 
main test window displays a simple command-line interface. You can 
use this interface to send commands to and view output from the 
instrument. 

The Communication Terminal test window contains these tabs: 

 Communication Terminal tab. Enter and send SCPI or TSP 
commands one line at a time.The Output Window displays the 
commands you send and any output from the commands. 

 Notes tab. Click in the window and type notes about the test. 
The text that you enter here is saved with the test project. 

 Help tab. Access user documentation that is specific to the test-
type you are using. 

 



 

 

IV Characterizer test window 
The IV Characterizer test type allows you to set up and run complex 
tests with no command-language programming. 

The tabs in the IV Characterizer test window are described in the 
following text. 

Source Measure tab 

Contains all of the source and measure settings you need to set up 
your test. If you cannot select an option, it is not available for your 
instrument. 

Spreadsheet tab 

When you execute an IV Characterizer test, you can see the values of 
data points in your test on this tab as they are being recorded. Data 
from your test is saved with the project and remains with the test 
until you execute the test again. When you execute the test again, data 
is overwritten. 

To save the data to an .xlsx or .csv file format, from the File 
menu, select the Excel Format or CSV Format option. 
 

Graph tab 

You can view your data in a graphical format as you run your test. 
You can set X -axis and Y1 and Y2-axis settings for measurement 
value or time. You can also select linear or logarithmic representation 
of your data, and you can change the color of graphed lines. 

After testing, you can change the presentation of your data on the 
graph by changing any of the settings on the graph tab. Data from 
your test is saved with the project. You can view it on the graph at a 
later time by selecting the data for each of the axes again. To save the 
graph to a .png file, from the File menu, select the Graph Image 
option. 

Notes tab 

Click in the window and type notes about the test. Text you type here 
is saved with the test project for future reference. 

Help tab 

Access user documentation specific to the test- type you are using. 
 



 

  

KickStart Help 
There are two places in the KickStart software interface that you can 
view help content: 

 Click  in the upper right corner of the interface to open this 
document as an Adobe Acrobat PDF file. 

 Click the Help tab in the main measurement window to open 
information specific to the communication terminal or the test 
type that you are using. 

Customizing the interface 
You can customize the appearance of the KickStart interface: 

 Hide or show the ribbon. Click the arrow in the upper right 
corner of the ribbon to hide or show it. 

 Dock, undock, show, hide, and close panels. Right-click the 
arrow next to the pin icon in a panel to open a menu of options 
for the panel. 

 Drag tabs in the main test window to reposition them. Click 
and hold the tab and drag it to the new location. 

 

 Display multiple window in the main test window. Select a 
tab and drag it to the graphic in the center of the main test 
window. The figure below shows the screen as the spreadsheet 
tab is clicked and dragged to the right side of the window. 

 

Changes you make to the layout and views in a project are not saved 
with the project. 

 



 

 

Create and run a test 
When you create a new test project in KickStart, you can set up and 
run a test in KickStart in a few simple steps: 

1. Select an instrument. 

2. Select the test type, test settings, and data view settings. 

3. Run the test. 

The following topics guide you through the steps to set up a 
KickStart test. 

Create a new test project 
To use KickStart, you must create a new test project or open an 
existing test project file, if you have one. 
 

To create a new test project: 
1. Select the File tab and click New. The Save As dialog box 

opens. 

2. Go to the location where you want to save your test projects.  
The default location for KickStart projects is My 
Documents\Keithley Instruments\KickStart. 

3. Enter a name for your test. 

4. Click Save. KickStart creates a new folder with the name of your 
test project. 

KickStart test files have a .kst file extension. Creating the test 
project does not create the .kst file. You must select an instrument 
and test type before you can save your test to a .kst file. 

 
 



 

  

To open an existing test project on your computer: 

The KickStart software installation includes one or more example 
projects. These examples are installed on your computer in the My 
Documents\Keithley Instruments\KickStart 
folder. 

1. From the File tab, click Open. The Open dialog box is displayed. 

2. Go to the folder that contains the test that you want to open. 

3. Select the .kst file. 

4. Click Open. 

When you create or open a test project, the KickStart interface 
changes. You can now see large icons at the bottom of the screen 
that represent the remaining steps to set up and run your test. The 
following topics describe these steps. 

 

Step 1: Select an instrument 
To select an instrument: 
1. Click the Select Instrument icon. A panel opens that shows the 

instruments that are connected to your computer. 

If the instrument that you want to connect to is not shown in the 
Instrument Configuration panel, click the Instruments tab on the 
ribbon and click Refresh Instrument Discovery.  
If you still do not see your instrument, check the connections from 
your computer to your instrument. For more information about remote 
communication interfaces and test connections, refer to the 
Reference Manual on the Product Information CD-ROM that came 
with your instrument. 

2. Right-click the instrument that you want to connect and select 
Add Instrument. 

 



 

 

Step 2: Select the test type 
After you have selected an instrument, the Select Test Type icon at 
the bottom of the KickStart interface is highlighted. Click the icon to 
open the Test Types panel. 

You can also open the Test Types panel by clicking the Test Types 
tab on the left side of the interface. 

 

The KickStart software comes with the following test- types: 

 Communication Terminal 

 IV Characterizer 

To select the test type: 
1. Right-click the test type you want and select Add Test Type. A 

new tab opens with the name of your test in the main area of the 
KickStart interface. 

2. On the ribbon, click Save. KickStart saves your test file with 
a .kst extension in the folder that you specified when you 
created your new test project. 

 

Select your test settings 

The settings for your test depend on the test type you are using. For 
more information about the settings for your test type, open your test 
and click the Help tab in the main test window. 

For additional information about how to use your instrument, see the 
documentation on the Product Information CD-ROM that came 
with your instrument. You can also access this information on the 
Keithley Instruments support website at www.keithley.com/support. 

Select your data view settings 

Some of the KickStart test- type plug- ins have options to view and 
save your test data on the Graph and Spreadsheet tabs in the main 
test window. The following topics describe these options. 

http://www.keithley.com/support


 

  

Graph tab 

You can see your data in a graph view as your test is running. You 
can also change the settings for the test data to see the data in a 
different way. 

If you save your test data, it remains through a power cycle until you 
run the test again. Every time a test is run in the same test project, 
the previous data is overwritten if the Clear Data Before Start Test 
check box is selected on the Settings tab on the ribbon. 

To set up the graph view: 
1. Click the Graph Tab. 

2. Click X-Axis on the left side of the main window. 

3. From the submenu that opens, select the data to plot to the X -
axis. 

4. Click Y1-Axis to open a submenu of choices. 

5. Select the data to plot to the Y -axis. 

6. You can also select the Y2-Axis and select a second type of data 
to plot. 

7. If you want to change the color of the data on the Y1-axis or the 
Y2-axis, click Axis Color to open the color palette. 

8. Drag the new color to the submenu of the Y -axis that you want 
to change. The color updates immediately in the main graph 
window. 

9. To change from Linear to Log (logarithmic) representation of the 
data, click Options and select the option you want. 

10. In the Options submenu, you can also choose to display or hide 
the legend and series information. 

When you run your test, your data is graphed in real- time on the 
Graph tab. If you save your test data after running the test, you can 
re-open the test at a later time. You can view the data or change the 
view settings to see the data in a different way. 

You can also zoom in and out in the graph view by dragging the 
graph to change the view. 
 



 

 

Spreadsheet tab 

If your test- type supports the spreadsheet view, you can view test 
data after the test is run. You can see your data in a spreadsheet view 
after execution of your test. 

.  

Step 3: Run the test 
Once you have configured your test and view settings, you are ready 
to run your test. 

1. To run the test, click the Execute Test icon in the lower right 
corner of the interface. 

2. To view the results of the test, you can click the Spreadsheet or  
Graph tab. 

3. To record notes about the test, click the Notes tab and type 
notes. 

4. To get information about the test type you are using, click the 
Help tab. 

5. After running the test, you can select different data from the test 
to show on the graph. 

 
 



 

  

Frequently asked questions 
Why is it taking so long to open KickStart? 

If the KickStart Software is taking a long to time to open or is not 
opening at all, you may need to download a patch for a known 
Microsoft bug. 

For more information, see Microsoft Article ID 2484841 at 
http://support.microsoft.com/kb/2484841/ en-us 

Link to download the patch: 
http://archive.msdn.microsoft.com/KB2484841/Release/ProjectRel
eases.aspx?ReleaseId= 5583 

Why can’t I move to step 2 when creating a new test? 

When you create a new test in KickStart, you must add the 
discovered instrument. Right- click the instrument and select Add 
Instrument. 

Once you have added an instrument, you can move to step 2, Select 
Test Type. To select the test type, right-click the test and select Add 
Test Type. 

Why are no ethernet instruments displayed in the Instrument 
Configuration window? 

There is a check box on the Instrument Settings tab in the ribbon 
that enables or disables discovery of ethernet instruments. Verify that 
instrument discovery is enabled. 

Only the instrument simulators are displayed in the Instrument 
Configuration panel. Why can’t I see my instrument? 

Check the prerequisites to KickStart installation in the Install the 
software section of this guide. 

How do I know which instrument is selected for testing by 
KickStart? 

On the Instruments tab, select the Identify Selected Instruments 
icon. The instrument that is selected for testing displays a message 
that shows which channel they are set to. 
 

http://support.microsoft.com/kb/2484841/%20en-us
http://archive.msdn.microsoft.com/KB2484841/Release/ProjectReleases.aspx?ReleaseId=5583
http://archive.msdn.microsoft.com/KB2484841/Release/ProjectReleases.aspx?ReleaseId=5583


 

 

Why doesn’t my Model 2450 show up in the list of instruments? 

The Model 2450 must be set to use the TSP command set to use it 
with the KickStart software. 

To select the TSP command set: 
1. On the Model 2450 front panel, press the MENU key. 

2. Under System, select Settings. 

3. Next to Command Set, select TSP. 

4. Reboot the Model 2450. 

If you select the SCPI 2400 command set, the Model 2450 appears as 
a Model 2400 in KickStart and some Model 2450 features are not 
enabled. 

Next steps 
For more information and to view documentation specific to your 
instrument, see the Keithley Instruments website, 
www.keithley.com. 

 

 

 

 

http://www.keithley.com/


 

 
 
 
 
 
 
 
 
 

  

 


	Kick Start Startup Software QSG
	Safety precautions
	What is KickStart?
	Instrument and test plug-ins
	KickStart features
	About the KickStart documentation
	Contact information

	Install the software
	Instrument and test-type plug-ins

	Explore the interface
	The ribbon
	The Instrument Configuration panel
	Instrument plug-ins

	The Test Types panel
	Test-type plug-ins

	The main test window
	Communication Terminal test window
	IV Characterizer test window

	KickStart Help
	Customizing the interface

	Create and run a test
	Create a new test project
	Step 1: Select an instrument
	Step 2: Select the test type
	Step 3: Run the test


	Frequently asked questions
	Next steps



